Developing a research poster is an important part of how you communicate your research. Posters are like a billboard display for your research. It is a representation of your work – the main ideas behind your research laid out in an organized and brief way. You can quickly display your ideas to a wide audience and receive feedback.

BEFORE YOU BEGIN

Before you begin developing or designing your content, check the organizer’s guidelines. Find out how much space you are allowed. Do the organizers require a certain poster design? Do they want you to include only certain sections? Read the guidelines carefully – it can be a horrible situation if you find yourself at a conference with a poster that is too large.

Also make sure to check with the printers, whether that is your department’s printer or Iowa State University Printing Services. They will have guidelines as well. Find out what size their printer can handle. And find out the time frame when you need to turn it in. Most printers require a 48-hour turnaround time.

PLAN AND DRAFT

Creating a research poster takes time to develop, and the most important and time consuming part is planning and drafting. This is the time to sit down and plan what will be on your poster. You need to decide what the main message or objectives of your research are. What is the most important thing you want to tell your viewers? You should not copy and paste the information from your paper or proposal onto your poster. Choose content that will match your audience. Make rough drafts of your poster – especially the content – and give it to others to comment on. Do not limit yourself to people in your department. Give it to those who might have limited background knowledge. Ask them to make specific and detailed comments on the content and layout.
You have a limited amount of space on your poster so you need to choose your ideas carefully. Try to focus on one or two central ideas from your research. Remember to keep your audience in mind. You will likely encounter three different audiences: professionals, the general public, or a mixture of the two. Find out what type of audience will be attending. Will it be a conference where only professionals attend? Or will it be a general audience that has little background knowledge? The key is to find out their background knowledge and adjust your message to fit.

Try not to rely on textual explanations – make it as visual as possible. People tend look at the pictures or figures first. Break up your text into bullets and lists and use short paragraphs. Divide your poster into sections and use short headings and subheadings. Try to limit yourself to 1,000 words on your poster.

Below are suggestions on how to reach the 1,000-word count. Be sure not to eliminate too much text. Too little information can destroy your research’s impact.

### POSTER SECTIONS

<table>
<thead>
<tr>
<th>Section</th>
<th>Word Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title, Authors, Department Affiliations</td>
<td>2-4 lines, avoid long titles</td>
</tr>
<tr>
<td>Abstract</td>
<td>Max: 50 words</td>
</tr>
<tr>
<td>Introduction</td>
<td>Max: 200 words</td>
</tr>
<tr>
<td>Materials and Methods</td>
<td>Max: 200 words</td>
</tr>
<tr>
<td>Results</td>
<td>200-300 words</td>
</tr>
<tr>
<td>Conclusions</td>
<td>Max: 300 words</td>
</tr>
<tr>
<td>References</td>
<td>10 or fewer citations</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>40 words or less</td>
</tr>
</tbody>
</table>
DESIGN ELEMENTS

After you have decided on content and have gathered pictures and graphs, it’s time to start thinking about laying out your poster. You must consider some important design elements while formatting your poster including images, type, color, white space, and layout. The rest of this article will discuss those design elements.

IMAGES

Images can include photos, graphs, or tables. Use images whenever possible, but if an image requires a lengthy explanation, you might need to reconsider how effective it is. An image should speak for itself, but include a short description with all your images.

Graphs and Charts

Graphs and charts are an excellent way to show your results quickly. They are usually the first items viewers will look at. Make graphs as simple as possible. Eliminate clutter like 3-D effects, shadows, and background colors. Use color to emphasize and differentiate between bars, lines, and pie wedges. Make sure all the labels (axis titles, numbers, legends) are readable from a distance. This will usually require you to edit most Excel graphs and charts.

BAR GRAPH

Use contrasting colors if you have several bars in your graph. To increase readability, avoid 3-D effects and background colors.

LINE GRAPH

Line graphs should be limited to no more than 4 lines if possible. Use arrows or circles to point out important data points.

PIE CHART

Pie charts should be limited to 6 wedges if possible. Use clear labels and contrasting colors.
Tables

If you are going to use tables on your poster make sure they are simple and do not overwhelm your viewers with a lot of numbers. If the table can be made into a graph, use a graph instead. One tip for tables: if you have a column of numbers with decimal points, align the numbers so the decimal points are aligned. It will help the table look less cluttered and will be easier to read.

Photos

Photos and other images can add a lot of impact to your poster. Avoid getting photos from the web. They are low quality images and usually copyright protected. Rule of thumb: if your image looks pixelated or blurry on the screen, it will also print pixelated.

When you are resizing photos in PowerPoint make sure to drag from one of the photo's corners. This will keep the photo proportional to the original size. Do not stretch or distort your pictures to fit.

When you want to place a photo or picture into PowerPoint do not copy and paste. On a PC, select the Insert tab, and then click the Pictures command in the Images group. A dialog box will appear. Locate and select the desired image file, then click Insert. On a Mac, select Photo from the Insert menu or select Picture from the Images group in the Format tab. A dialog box will appear. Locate and select the desired image file, then click Insert.

A small detail to highlight your pictures is to add a thin border. This will make your pictures stand out from the text.

Avoid using clip art. It distracts from your message and is usually not professional.

One of the biggest problems on most posters is logo use. Even though it is a small detail, you are advertising your department or partners. Contact your department for their logo. Avoid getting logos from the web unless it specifically states that they are high quality versions. Do not alter any logos and make sure to resize them correctly. Use only the official Iowa State University logos. They are available for download at www.print.iastate.edu/nameplates.aspx.

TYPE

Selecting the right fonts and tips for styling content

Choosing fonts is an important part of designing your poster. Limit yourself to two fonts – that includes fonts used in tables and graphs. Avoid script or decorative fonts like Comic Sans, Brush Script, or Papyrus. They are unprofessional and illegible. Use sans serif fonts for titles and section headings and use serif fonts for the content.

Iowa State has selected two font families for their communication materials: Univers and ITC Berkeley. If you would want to use these fonts, they are available for purchase from TechCYTE at the University Book Store.

If you do not want to purchase the fonts, Iowa State has selected Arial and Times New Roman as substitutes since they share some of the same characteristics of Berkeley and Univers.

For more information about the Iowa State fonts, go to www.brandmarketing.iastate.edu/brand-elements/typography.
Font Sizes

Here are some basic guidelines to follow when choosing the size of your text:

<table>
<thead>
<tr>
<th>Section</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>70-100 point</td>
</tr>
<tr>
<td>Authors and Department Affiliations</td>
<td>50-80 point</td>
</tr>
<tr>
<td>Section Headings</td>
<td>40-60 point</td>
</tr>
<tr>
<td>Subheadings</td>
<td>28-35 point</td>
</tr>
<tr>
<td>Content</td>
<td>28-36 point</td>
</tr>
</tbody>
</table>

Keep in mind that your poster needs to be seen from three to five feet away. The title should be large and bold. The authors’ names should go after the title and should be larger than the content. Section headings should be large and clear. Viewers should be able to skim your poster and find the section headings. Content should be 28 to 36 point. Anything under 28 is hard to read.

Here are a few tips when setting up and styling your content:

» Avoid underlining – use bold or italics to emphasize.
» To save space on your poster, use only one space after periods.
» Set your own tabs. The default tab is usually set in too far.
» Adjust line spacing, but keep it at least at single spacing.
» Do not justify the content. Leave the content aligned left. The broken lines help guide the viewer to the next line.
» Do not use all caps for sentences or long blocks of text. It takes twice as long to read and comprehend.

SANS SERIF
Sans serif fonts do not have projections at the end of the letters. Letters have the same stroke thickness throughout.

SCRIPT / DECORATIVE
Script fonts look handwritten and have connecting strokes between letters. Decorative fonts are ornate.

SERIF
Serif fonts have a slight projection finishing off the stroke of the letters. The letters have thin and thick strokes.

Sample

Sample

Sample
You should definitely add color to your poster. It helps draw viewers in, but use it sparingly. Two or three colors are enough.

Avoid gradients because they tend to print poorly.

Use warm colors like reds and oranges or calming colors like light blues and greens.

When in doubt stick with the general rule: A light colored background and dark text.

Iowa State University Colors

The list of Iowa State colors and additional information about their use can be found at www.brandmarketing.iastate.edu/brand-elements/color-palette.

IOWA STATE UNIVERSITY PRIMARY PALETTE: Use these colors for large areas of color or as an accent color.

IOWA STATE UNIVERSITY SECONDARY PALETTE: Use these colors to complement the primary colors.

White Space

White space – areas free of any text or images – is an important design element. It gives your readers a break as they read your poster. Leave space between your images and text and plenty of space between columns. Try to use ½" column gutters.
**Introduction**

Riam sant mi, cor seque pratquatem et pra vent officias vid min rere, andes magnam, seceation re rero ea simendel invelignatus pre pore nonsequy dem quatumtur, ut haria volenda nieturio illaut ditatis nonseque as quataes sinullia nobit ute antuunt pernatzquis quas coneece derio. Tur, nonsequy cus molorio. Et maio dit volupta nimollum qui abore cororvidui volendelibus non conempor rent quam, cuptraectem quiqam ant.

Um quiae sae el id quodi omnis vendell abborpor aut voloror porporum cusda int:

- Id quibusapid que expel maiorentiur
- Id quibusapid que expel maiorentiur
- Id quibusapid que expel maiorentiur
- Id quibusapid que expel maiorentiur

**Objectives**

Riam sant mi, cor seque pratquatem et pra vent officias vid min rere, andes magnam, seceation re rero ea simendel invelignatus pre pore nonsequy dem quatumtur, ut haria volenda nieturio illaut ditatis nonseque as quataes sinullia nobit ute antuunt pernatzquis quas coneece derio.

**Materials and Methods**


Um quiae sae el id quodi omnis vendell abborpor aut voloror:

1. Et maio dit volupta nimollum qui abore cororvidui volendelibus non conempor rent quam, cuptraectem.
2. Id quibusapid que expel maiorentiur
3. Id quibusapid que expel maiorentiur

**Results**

Riam sant mi, cor seque pratquatem et pra vent officias vid min rere, andes magnam, seceation re rero ea simendel invelignatus pre pore nonsequy dem quatumtur, ut haria volenda nieturio illaut ditatis nonseque as quataes sinullia nobit ute antuunt pernatzquis quas coneece derio.

Vitatum qui rem cus, et ut hilibeaturit lauhterropp lauhtemodis state porepded que maximpo reptq uatius non con cus, in et fugiand uciistotat maxim niamos nullabo. Tur, nonsequy cus molorio.

Riam sant mi, cor seque pratquatem et pra vent officias vid min rere, andes magnam, seceation re rero ea simendel invelignatus pre pore nonsequy dem quatumtur, ut haria volenda nieturio illaut ditatis nonseque as quataes sinullia nobit ute antuunt pernatzquis quas coneece derio.

Vitatum qui rem cus, et ut hilibeaturit lauhterropp lauhtemodis state porepded que maximpo reptq uatius non con cus, in et fugiand uciistotat maxim niamos nullabo.

**Conclusion**

Riam sant mi, cor seque pratquatem et pra vent officias vid min rere, andes magnam, seceation re rero ea simendel invelignatus pre pore nonsequy dem quatumtur, ut haria volenda nieturio illaut ditatis nonseque as quataes sinullia nobit ute antuunt pernatzquis quas coneece derio. Tur, nonsequy cus molorio. Et maio dit volupta nimollum qui abore cororvidui volendelibus non conempor rent quam, cuptraectem quiqam ant.

**References**

- Id quibusapid que expel maiorentiur
- Id quibusapid que expel maiorentiur
- Id quibusapid que expel maiorentiur
- Id quibusapid que expel maiorentiur

**Acknowledgements:** Add acknowledgements here.